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AF-1501
Single Channel, Analog Frame Grabber for CompactRIO

Features

• Accepts NTSC, PAL and 
SECAM analog video data 
(single input).

• Standard 75 ohm BNC 
connector.

• High-speed 9-bit analog-to-
digital converter (ADC)

• Frame rate up to 30 
frames/sec1. 

• Ships with LabVIEW 
FPGA/RT drivers for easy 
integration with National 
Instruments cRIO environment.

• QVGA progressive scan mode 
for motion-sensitive 
applications.

• Built-in Hardware Accelerated 
Thresholding: two 
customizable thresholds can be 
used independently or together.

• Selectable image inversion
• Programmable Region of 

Interest (ROI) for arbitrary 
frame size.

• Industrial Temperature Range 
(–40 °C to +70 °C)

1 Deployment target dependent: might require the use of one of the special features to achieve this frame 
rate.

Author: Erik Smeby www.movimed.com

http://www.movimed.com/


MoviMED
15540 Rockfield Blvd., Suite C-110

Irvine, CA 92618
949-699-6600 Phone

949-699-6601 Fax

Rev.: 4 02/19/2010

Revision History

REV. DATE AUTHOR DESCRIPTION

0 09/16/2009 Erik Smeby Initial Release

1 09/29/2009 Erik Smeby Added additional figures to “Special Features” section 
for clarification.

2 12/09/2009 Erik Smeby Added “Features” section to title page and revision 
history page. Added “Table of Contents”, “Physical 
Dimensions”, and “AF-1501 Block Diagram” 
sections.

Renamed “Feature Compatibility” to “Feature Inter-
compatibility” and demoted one level.

Added “Electromagnetic Compatibility” and “CE 
Compliance” items to “Specifications” section.

Reformatted and reordered document.
Added “Higher clock frequencies may be used, but the 

driver VI…” in item 16 of the “Getting Started” 
section.

3 02/11/2010 Erik Smeby Revised title page photograph.
Added Figure 1 to “Physical Dimensions” and 

renumbered.
Revised “Getting Started”.
Revised “Requirements” section.

Replaced “LabVIEW 8.6 or later” with “LabVIEW 
2009 or later” in “Software”. 

Replaced “TBD” in Hardware, Target, Memory & 
Processor with “12 MB min.” and “266 MHz 
min.”, respectively. 

Revised Table 1.
Revised Figure 23.
Moved Para. “Setup a valid resolution … test patterns 

are fixed to 640x480.” in section “Initializing the AF-
1501 module” to section “Configuring the AF-1501”.

Added “... as well the values for X0 and X1” to 
“Resolutions in PSS Mode must be divisible…”.

Renamed section titles in “Advanced API Functions”:
“Setting the Operational Mode” IS “Configuring the 

Image Mode”
“Changing the Region of Interest” IS “Configuring 

the Region of Interest”
“Changing the Threshold Levels” IS “Configuring 

the Threshold Levels”
“Changing the Test Pattern” IS “Configuring the 

Test Pattern”

4 02/19/2010 Erik Smeby Revised “Software” in Introduction.
Revised “Safety Information”; added “Disclaimer”.
Deleted Item 1, “Install the AF-1501 drivers by 

launching...” from “Getting Started”, “Setup and 

AF-1501 Operating Instructions www.movimed.com Page i

http://www.movimed.com/


MoviMED
15540 Rockfield Blvd., Suite C-110

Irvine, CA 92618
949-699-6600 Phone

949-699-6601 Fax

Rev.: 4 02/19/2010

REV. DATE AUTHOR DESCRIPTION

Installation”.
Added “Software Installation on the RIO Target” and 

“Installation of the AF-1501 Driver” to “Getting 
Started.” 

Added “Understanding the AF-1501 Driver”.
Added “Integrating the AF-1501 with User 

Applications”.
Added “Available Modes of Operation”.
Revised “Special Features”:

Added “When to Use …” and “How to Use ...”
Added “Test Pattern Generator”

Revised “Feature Inter-Compatibility”
Updated Table "Special Feature Inter-compatibility 
Chart”

Revised “Specifications":
Revised “Active mode (transfer)” from “TBD” to “1 
W max.”.
Deleted “Thermal Dissipation”.

Revised “Application Programming Interface” and 
“Advanced API”
Removed redundant descriptions of “error in” and 
“error out”.
Removed redundant descriptions of “Configuration 
(Read)”, “Mode (Read)”, “ROI (Read)”, etc.

AF-1501 Operating Instructions www.movimed.com Page ii

http://www.movimed.com/


MoviMED
15540 Rockfield Blvd., Suite C-110

Irvine, CA 92618
949-699-6600 Phone

949-699-6601 Fax

Rev.: 4 02/19/2010

Table of Contents
Introduction.....................................................................................................................1

Minimum Requirements:............................................................................................1
Physical Dimensions.......................................................................................................2
Safety Information..........................................................................................................2

Disclaimer...................................................................................................................2
AF-1501 Block Diagram.................................................................................................3
Connecting the AF-1501.................................................................................................3
Getting Started................................................................................................................4

Software Installation on the RIO Target.....................................................................4
Installation of the AF-1501 Driver.............................................................................5
Setup and Installation.................................................................................................5
Programming the AF-1501.........................................................................................8
Example 3: Barcode Reader.....................................................................................10

Understanding the AF-1501 Driver...............................................................................12
The AF-1501 FPGA driver.......................................................................................13
The AF-1501 DMA Channel (FIFO)........................................................................13
The AF-1501 Real-Time Driver...............................................................................14

Integrating the AF-1501 with User Applications..........................................................15
FPGA vs. Scan Mode...............................................................................................15
Adding Custom FPGA code.....................................................................................15
Compiling the FPGA Driver VI Code......................................................................16
Creating a Real-Time application.............................................................................16
Creating a Host PC application................................................................................17
Using the AF-1501 in a Different Slot than the Default...........................................17

Available Modes of Operation......................................................................................19
Default Configuration...............................................................................................19
How to Set the Configuration...................................................................................19
Valid Settings............................................................................................................20

Special Features............................................................................................................21
Progressive Skip Sampling.......................................................................................21
Programmable Region of Interest.............................................................................23
Speed Optimized Mode (4-bit).................................................................................25
Image Inversion........................................................................................................25
Hardware Accelerated Thresholding (1-bit).............................................................26
Test Pattern Generator..............................................................................................29
Feature Inter-compatibility.......................................................................................31

Sleep Mode....................................................................................................................31
Specifications................................................................................................................31

Input Characteristics.................................................................................................31
Digital Data Format..................................................................................................32
Power Requirements.................................................................................................32

AF-1501 Operating Instructions www.movimed.com Page iii

http://www.movimed.com/


MoviMED
15540 Rockfield Blvd., Suite C-110

Irvine, CA 92618
949-699-6600 Phone

949-699-6601 Fax

Rev.: 4 02/19/2010

Physical Characteristics............................................................................................32
Electromagnetic Compatibility.................................................................................32
CE Compliance.........................................................................................................32

Application Programming Interface..............................................................................33
Opening a Session to the AF-1501...........................................................................33
Configuration of the AF-1501..................................................................................34
Grabbing Images from the AF-1501.........................................................................35
Closing a Session to the AF-1501............................................................................35

Advanced API Functions...............................................................................................36
Using Auto Configure...............................................................................................36
Configuring the Image Mode...................................................................................37
Configuring the Region of Interest...........................................................................38
Configuring the Threshold Levels............................................................................38
Configuring the Test Pattern.....................................................................................39

AF-1501 Operating Instructions www.movimed.com Page iv

http://www.movimed.com/


MoviMED
15540 Rockfield Blvd., Suite C-110

Irvine, CA 92618
949-699-6600 Phone

949-699-6601 Fax

Rev.: 4 02/19/2010

List of Figures
Physical Dimensions for the AF-1501.................................................................................2
Functional Diagram of the AF-1501....................................................................................3
Connecting a Video Source to the AF-1501........................................................................3
Installation of Required Components on the RIO Target.....................................................4
Adding a New RIO Target to the Project.............................................................................5
A Project Setup for the AF-1501 .........................................................................................6
Front Panel of Example 2 after Grabbing an Image............................................................7
Example Program to Grab an Image from the AF-1501......................................................8
Location of AF-1501 Drivers in Functions Palette..............................................................8
Barcode Reader Example Code.........................................................................................10
Sample Barcodes (Code 128).............................................................................................11
Sample Barcodes (UPC-A)................................................................................................11
AF-1501 Communication Layers......................................................................................12
Location of the AF-1501 API in the Functions Palette......................................................14
Accessing User Code Embedded in the AF-1501 Driver..................................................16
Adding New Module I/O Nodes to the Project..................................................................18
Configure using a Constant................................................................................................19
Configure using Bundle.....................................................................................................19
Progressive Skip Sampling................................................................................................22
Jaggedness Due to Interlacing (640x480)..........................................................................22
Removed Jaggedness using PSS Mode (320x240)............................................................22
Region of Interest...............................................................................................................23
Image without ROI............................................................................................................24
Smaller Image using ROI...................................................................................................24
Image of Bracket in 8-Bit Mode........................................................................................25
Image in 4-Bit Mode (SOM)..............................................................................................25
Original Image of a sbRIO PCB........................................................................................26
Inverted Image of a sbRIO PCB........................................................................................26
Thresholding......................................................................................................................27
Original Image Before Thresholding.................................................................................27
Image After using a Low Threshold of 180.......................................................................27
Image After using a High Threshold of 70........................................................................28
Image After using a Both Threshold Modes (Window).....................................................28
Original Image of AF-1501................................................................................................28
Low Threshold of 220........................................................................................................28
High Threshold of 220.......................................................................................................28
Combined Threshold Modes..............................................................................................28

AF-1501 Operating Instructions www.movimed.com Page v

http://www.movimed.com/


MoviMED
15540 Rockfield Blvd., Suite C-110

Irvine, CA 92618
949-699-6600 Phone

949-699-6601 Fax

Rev.: 4 02/19/2010

Introduction

The AF-1501 captures analog video on the CompactRIO platform. The digitized data is 
transferred across the CompactRIO backplane to the real-time processor through a direct 
memory access (DMA) channel. The real-time processor then converts the image to a 
format that can easily used with IMAQ for easy integration with National Instruments' 
machine vision libraries. There are a number of built-in features into the AF-1501 that 
reduce the amount of processing required for common image processing functions. 

Minimum Requirements:
Software

Host Computer
LabVIEW ........................2009 or later
LabVIEW Real-Time.......9.0.0 or later
LabVIEW FPGA..............9.0.0 or later
LabVIEW Vision..............9.0.0 or later
AF-1501 Driver................1.x.x

Target
LabVIEW Real-Time.......9.0.0 or later
NI RIO.............................3.2.x or later
NI VISA ..........................4.6.x or later
NI VISA Server ...............4.6.x or later
NI Vision RT ...................9.0.0 or later

Hardware
Target.....................................Single-Board RIO or Compact RIO

Memory............................12 MB min.
Processor..........................266 MHz min.
Slot...................................1 available
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Physical Dimensions

Figure 1: Physical Dimensions for the AF-1501

Safety Information

Disclaimer

Operate the AF-1501 only as described in these operating instructions. The safety 
guidelines and specifications in this document are specific to the AF-1501. Any other 
components in the system might not meet the same safety ratings and specifications. 
Refer to the documentation for each component in the system to determine the safety 
ratings and specifications for the entire system.

MoviMED's AF-1501 is not authorized for use as critical component in life support 
devices or systems without the express written approval of MoviMED.

Life support devices or systems are devices or systems which, (a) are intended for 
surgical implant into the body or (b) support or sustain life, and (c) whose failure to 
perform when properly used in accordance with instructions for use provided in the 
labeling, can be reasonably expected to result in a significant injury of the user.

A critical component in any component of a life support, device, or system whose failure 
to perform can be reasonably expected to cause the failure of the life support device or 
system, or to affect its safety or effectiveness.
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AF-1501 Block Diagram

Figure 2: Functional Diagram of the AF-1501

The incoming analog video signal is digitized by the analog video front end (AFE) and 
buffered by the on-board FPGA . The image is temporarily stored and de-interlaced by 
on-board random access memory (RAM). The on-board FPGA transfers images to the 
RIO back plane FPGA upon request. Refer to Figure 2 for system diagram of the AF-
1501 module.

Connecting the AF-1501

Connect a composite video source to the BNC on front panel on the module. Plug the 
module into an available slot on the CompactRIO chassis. No external power supply is 
required.

Figure 3: Connecting a Video Source to the AF-1501
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Getting Started

Software Installation on the RIO Target

To install the proper software on CompactRIO or Single-Board RIO hardware, you must 
first install it on the host PC. The only necessary components listed under Minimum 
Requirements, Software in Introduction section. The software components installed the 
PC can be verified in Measurement & Automation Explorer (MAX) by expanding the 
software tab under My System. Once it has been verified that the host PC has the correct 
software, it needs to installed on the CompactRIO controller to meet the minimum 
requirements for transferring an image from the RT target.

Before you powering up the CompactRIO or Single-Board RIO hardware, install the 
AF-1501 frame grabber module into Slot 1. Once the module has been plugged in, 
proceed to power the system up and connect it to the local network via the Ethernet port 
on the controller.

The CompactRIO controller should appear in MAX under the Remote Systems tab. 
Expand the target , right-click on Software, and select Add/Remove Software. This 
opens the LabVIEW Real-Time Software Wizard. Select Custom software installation 
and click Next. Select Yes to continue with the manual installation. The three required 
pieces of software are NI NI Vision 9.0, LabVIEW Real Time 9.0 and NI RIO 3.2.x. 
Install any required dependencies of the mentioned three components. Once you have 
selected all of these to install, click Next to begin the installation (See Figure 4).

Figure 4: Installation of Required Components on the RIO Target

When you have finished installing the required software and the system has rebooted, the 
RIO system has the required systems components for interfacing with the AF-1501 
driver.
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Installation of the AF-1501 Driver

In order to operate the AF-1501, the user needs to download the driver from 
http://www.movimed.com. Once the driver installer is saved to disk, double click on it. 
The installer will prompt the user to select where to install the necessary files. The user 
will have the option to install other options such as documentation and examples. If the 
user is satisfied with the default settings for file locations, click Next until you reach the 
last window and click Install. 

Setup and Installation
1. Install the AF-1501 into an available slot on the RIO Target while the power is 

off.
2. Power on the RIO Target.
3. Open LabVIEW and select from the File » New Project to create an empty 

project.
4. Right-click the Project icon in Project Explorer and select New » 

Targets and Devices… (See figure below).

Figure 5: Adding a New RIO Target to the Project
5. In the Targets and Devices section of the Add Targets and Devices windows, 

select a target from either the Real-Time CompactRIO or Real-Time Single-Board 
RIO and click OK.

6. In the Select Programming Mode dialog box, select 
LabVIEW FPGA Interface and click Continue.

7. If the LabVIEW prompts to discover C Series modules, click Discover.
8. If the AF-1501 module appears the the FPGA Target tree (as “Slot 1, AF-1501”, 

for example), skip to step 13.
9. If the module was not automatically detected, right-click the FPGA Target tree 

and select New » C Series Modules … .
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10. With the “Existing target or device” option selected, expand the 
C Series Module tree to try automatically detecting the module.

11. If the module was not detected in step 10., then select “New or target device” 
and then select “C Series Module” under Targets and Devices. Click OK to 
continue.

12. In the “New C Series Module” dialog box under Module Type, select AF-1501 
from the drop-down menu. Select the Slot the module is connected in. If the 
module is not in the list, the driver is not correctly installed. Click OK.

13. The module will show up in the FPGA Target tree. If not, check that the driver is 
properly installed and the module is correctly installed in the chassis slot. If steps 
11. through 12. were followed, the module should appear in Project Explorer if 
the driver is installed properly. (See figure below)

Figure 6: A Project Setup for the AF-1501 
14. Open the example from the NI Example Finder under Toolkits and Modules » 

FPGA » CompactRIO » Module Specific » Analog Input » MoviMED » 
AF-1501 » AF-1501 Examples.lvproj. Copy (drag while holding the control 
key) the “AF-1501 FPGA Drivers” folder from the example project under the 
FPGA Target tree into the FPGA Target tree in your project. This folder 
contains an “Out” FPGA FIFO and the “AF-1501 FPGA Driver vX.Y … .vi” 
main FPGA driver VI file.

15. Copy the derived clock (expand the the base clock tree) from the example project 
or create a FPGA Derived Clock named “AF-1501 Bus Clock” at 70 MHz, or 
higher, if the target permits. Verify the clock is at this frequency exists and no 
error exists in the project with the clock. It will be necessary to edit the clock 
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properties if any modifications have been made to it. Higher clock frequencies 
may be used, but the driver VI may not compile on some targets.

16. Install the real-time drivers into your project by copying the folder named 
“Real-Time Drivers” and “Examples” from the example project under the 
RIO Target tree in your project under the RIO Target tree.

17. Open the low-level driver folder as created in step 16. Right-click the FPGA 
driver VI for the slot the module is installed in and select Compile, if not done 
already. The real-time driver will not run without a compiled copy of the low-
level driver.

18. Open the “AF-1501 Open.vi” real-time driver and check to make sure it is not 
broken (broken, gray run icon). If it is broken, the driver may not be installed 
properly or compiled.

19. Connect a video source to the AF-1501.
20. Copy Example 1 from the NI Example Finder (Help » Find Examples...) under 

Toolkits and Modules » FPGA » CompactRIO » Module Specific » Analog 
Input » MoviMED » AF-1501 » AF1501 Examples.lvproj. The VI(s) should be 
copied to the project created in the previous section.

21. Run Example 1 and, optionally, Example 2 with the default settings. The 
Configuration control on the front panel of either VI allows the user to test 
different settings on the AF-1501.  

22. Switch to the block diagram to display the code used to communicate with the 
AF-1501.

Figure 7: Front Panel of Example 2 after Grabbing an Image
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Programming the AF-1501

Figure 8: Example Program to Grab an Image from the AF-1501

Figure 9: Location of AF-1501 Drivers in Functions Palette

Initializing the AF-1501 module

When creating your own LabVIEW code to access the AF-1501, the 
module first must be initialized with the “AF-1501 Open.vi” function2. 
Remaining VI functions need to have session and error terminals cascaded 
to each other. Wire either a constant or control to the RIO Target input 
and the Slot input. The RIO Target was setup in the section entitled, Setup
and Installation, Step 5. 

2 LabVIEW must be restarted before the drivers will appear in the functions palette.
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Configuring the AF-1501

When configuring the AF-1501, the “AF-1501 Configure.vi” function 
must be called. The configuration functions sets or gets the Bit Mode, 
Image Invert, Threshold, Region of Interest (ROI), and Progressive Skip 
Sampling (PSS).

Bit Mode selects from 8-bit, 4-bit, 1-bit (threshold), or a test pattern (8-
bit). The invert option allows the output image to be inverted bit-wise. 
This feature is useful in combination with thresholding. However, the 
output is not affected by the invert setting when a test pattern is selected. 
When using PSS Mode, the output resolution is reduced by half. The 
frame rate will be higher as a result. 

Threshold mode is activated by setting the Bit Mode to 1-bit, and setting 
either the low or high threshold comparison enable to TRUE. A threshold 
value must be set. When neither of the threshold comparators are enabled, 
the output will be black.

Setup a valid resolution with the X Size and Y Size inputs. The default 
resolution is 640x480. Resolutions in ROI Mode must be divisible by 
two (2), and resolutions using thresholding must be divisible by six (6), as 
well the values for X0 and X1. The resolution for the test patterns are 
fixed to 640x480.

Note: Specifying an invalid resolution will result in errors or 
unpredictable behavior. See Table 1 for a list of valid settings.

Grabbing an Image from the AF-1501

Call the “AF-1501 Snap.vi” to grab an image. The output data format is 
IMAQ. The output then can be wired to additional IMAQ or machine 
vision functions for processing or display.

Closing communication with the AF-1501

Call the “AF-1501 Close.vi” when the loop ends to shutdown the driver at 
end of your program. Not following this step will lead to errors and 
unpredictable results.
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Example 3: Barcode Reader
Implement the following code in LabVIEW:

Figure 10: Barcode Reader Example Code

1. Add the basic AF-1501 functions from the User Libraries » MoviMED » 
AF-1501 palette. Create the controls and indicators shown in Figure 10.

2. For configuration, create a constant from the input terminal. Then, either set the 
values directly in the constant, or wire the constant into a Bundle by Name 
function for clarity. 

Note: Settings not shown in Figure 10 will not affect this example and can 
be set to their default values.

Note: For a faster response time, use 320x240 with PSS enabled instead 
of 640x480.

3. Use the “IMAQ Read Barcode” function from the Vision and Motion » 
Machine Vision » Instrument Readers function palette.

Note: The “IMAQ Read Barcode” function will work with grayscale but at  
a much slower speed.

4. Place an Image Display (IMAQ) indicator on the front panel from the from the 
Vision control palette. Right-click the indicator and select the Palette » Binary 
option.

5. Right-click the IMAQ indicator on the block diagram and select Create » 
Property Node » ROI.

6. Set the Barcode Type to Code 128 on the front panel. You may experiment with 
detecting the other barcode types as well.

7. Set the threshold (high) to a value between 50 and 120, depending on the image 
quality and brightness. It might be necessary to display the image in grayscale 
mode first to find a good value for the threshold.
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Note: The camera should be in focus for this exercise.

8. Press the Run button to start the VI. You may change the barcode type during 
execution.

9. Aim the camera at one the following barcodes to scan and detect the secret 
message(s):

Figure 11: Sample Barcodes (Code 128)

Figure 12: Sample Barcodes (UPC-A)

10. Press the Stop control you created when finished or need to adjust the threshold 
value.
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Understanding the AF-1501 Driver

Understanding the AF-1501 driver for LabVIEW is crucial for users using this C-series 
module in their applications. It is recommended to complete the “Getting Started” section 
prior to reading this section, as it will further help to understand the AF-1501 driver.

The AF-1501 driver has three main components:

• The AF-1501 FPGA Driver

• The AF-1501 DMA Channel (FIFO) 

• The AF-1501 Real Time Driver

Figure 13 shows how the different components of the AF-1501 map into the actual 
LabVIEW project.  In Figure 13, we can see from bottom to top the following blocks:

Figure 13: AF-1501 Communication Layers
• Analog Video Source: Grabs the image and sends it to the frame grabber using a 

particular video standard (NTSC/PAL/SECAM).

• AF-1501 Module: Performs de-interlacing, buffers the image, and sends it to the 
RIO FPGA backplane.

• FPGA Backplane (on RIO Target): Receives the image from the module and 
sends it up to the RT processor via a DMA channel (FIFO).

• RT Processor (on RIO Target): receives the image from the DMA channel and 
processes it.

• Host PC (optional): Allows the user to program, monitor and debug the 
application.
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Note: LabVIEW projects are organized with a hierarchical structure. This  
structure locates the FPGA Target under the RT Target tree. The C-Series Module  
is under the FPGA Target tree. This structure should not be confused with the  
block diagram described previously.

Note: The presence of the analog video source is transparent to LabVIEW.  
If no source is connected, a black image will be captured.

The three levels the user can interface with in their applications are the FPGA Backplane, 
the RT Processor, and the optional Host PC. The following subsections will describe how 
to program in those three levels using LabVIEW as well as a brief description of the 
driver.

The AF-1501 FPGA driver

The driver has the following characteristics and requirements:

• Performs the low-level communication with the AF-1501 module.

• Transfers the data to the RT processor through a DMA channel (FIFO).

• Clock speed dependent

• Requires compilation

Note: The compilation frequency of the AF-1501 FPGA driver is target  
and custom user FPGA code dependent. This compilation frequency might affect  
the performance of the application. See Compiling the FPGA Driver VI Code 
section for details.

Note: To locate the AF-1501 FPGA driver go to your project and under  
Help » Find Examples you will open the NI Example Finder. Type AF-1501 in the  
search field. Open the “AF-1501 Examples” project. The AF-1501 FPGA driver  
can be found under RT CompactRIO Target » Local Chassis » FPGA Target » 
AF-1501 Drivers » AF-1501 Driver vX.X .

The AF-1501 DMA Channel (FIFO)

This element allows the transaction of image information from the FPGA level to the RT 
level. The AF-1501 channel uses one (1) of the three (3) DMA channels available on the 
RIO target. The DMA channel is called “Out” and resides in the example project. Only a 
single instance of the DMA channel is allowed at the FPGA level. As the AF-1501 FPGA 
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driver already has that instance the user is not allowed to invoke that Channel at the 
FPGA level any more.

Note: To locate the AF-1501 DMA Channel, go to Help » Find Examples 
and open the NI Example Finder. Type AF-1501 in the search field. Open the  
“AF-1501 Examples” project.  The AF-1501 DMA Channel can be found under  
RT CompactRIO Target » Local Chassis » FPGA Target » AF-1501 Drivers » 
Out.

The AF-1501 Real-Time Driver

The AF-1501 Real-time driver has the following characteristics:

• Assembles the image on the RT process with two possible image output formats: 
IMAQ image (for with IMAQ compatible image processing and machine vision 
functions) and 2D image array.

• Fully integrated with LabVIEW as a add-on functions palette after the driver 
installation. The driver API is located under User Libraries » MoviMED » AF-
1501 as shown in Figure 14. 

Figure 14: Location of the AF-1501 API in the Functions Palette

Programming an application that involves image acquisition with the AF-1501 always 
requires the following VIs: Open, Configure, Grab Image, Close. This follows the typical 
IMAQ paradigm. Refer to the AF-1501 API or the online help for more details how to use 
the Advanced functions. 
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Integrating the AF-1501 with User Applications

FPGA vs. Scan Mode

The AF-1501 is only supported under FPGA mode because it has a driver at the FPGA 
level. If the user application requires the use of Scan Mode (Scan Engine) there are two 
alternatives:

• Use Hybrid (Mixed) Mode : follow the instructions on the document "Using Scan 
Engine and FPGA Simultaneously on a CompactRIO", Document ID: 
4XRBMIUV from National Instruments website.

• Write a simple FPGA piece of code to poll values from the FPGA level to the RT 
level using the front panel interface. See Adding Custom FPGA code for more 
details.

Warning: MoviMED does not recommend the use of Hybrid Mode. Scan 
Mode requires two additional DMA channels. Using Hybrid Mode will use all of  
the three available DMA channels (2 for the Scan Engine and 1 for the AF-1501). 

Adding Custom FPGA code

If the user application does not need custom FPGA code, skip this section and go to 
Compiling the FPGA Driver VI Code. If the user application requires custom FPGA code, 
add custom FPGA code to the FPGA driver VI without modifying the existing code on 
the block diagram. Locate the AF-1501 FPGA driver (see The AF-1501 FPGA driver for 
more details) and add any custom user code outside the single cycle loop used for the 
FPGA driver. Do not change any signals going in or out from the single cycle loop. The 
user can create controls and indicators as needed, use different clock rates and create any 
programming item as long as its execution does not interfere with the AF-1501 FPGA 
driver.

The user FPGA code functionality can be accessed from driver front panel by using a 
R/W Control VI's from the FPGA Interface palette. See Figure 15 as a simple example of 
writing a custom signal at the FPGA level and reading a custom value from the FPGA 
level together with imaging functions. Find also the location of the FPGA VI's depicted in 
the same figure.
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Figure 15: Accessing User Code Embedded in the AF-1501 Driver

Warning: Any change to the name of the FPGA driver will require the user  
to relink that FPGA VI on the open reference located in the Open Session VI of  
the AF-1501 RT driver and the “AF-1501 Session.ctl”.

Compiling the FPGA Driver VI Code

Once your FPGA code is ready (with or without custom FPGA code) you will need to 
compile the FPGA code. In order to do that go to the Project and under FPGA target find 
the FPGA driver VI. Right-click the VI and select Compile. Compilation typically takes 8 
to 13 minutes for the AF-1501 FPGA driver alone. Custom FPGA code could extend 
compilation times.

Note: Compilation clock rates vary among backplanes. The default  
compilation frequency is 80 MHz. Depending on the FPGA code, the achievable  
compile frequency might vary. If the compiler, returns an error about the  
compilation frequency, the user should use a frequency below the maximum 
allowed frequency displayed by the FPGA error during compilation.

Creating a Real-Time application

See The AF-1501 Real-Time Driver to program Real-Time vision applications using 
information coming from the AF-1501. The user can find the AF-1501 API functions in 
the User Libraries » MoviMED » AF-1501. First,a session needs to be opened to the 
AF-1501. Next, the driver needs to configure the module. Third, the “Snap” function is 
called to grab an image. When using IMAQ output format of the driver, the user can pass 
image into the NI Vision functions set for seamless integration with National Instruments' 
machine vision and image processing libraries. After finished grabbing images, the 
session needs to be closed.
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Creating a Host PC application

Host PC applications can take advantage of the National Instruments' built-in data 
transferring mechanism from the RT target for development purposes. This means that 
any code running on the RT target accessing the AF-1501 can be moved to the host PC. 
In order to code a host PC application using the AF-1501, the user should follow exactly 
the same procedure as if they were coding an application on the RT target, except the VI 
should be moved to “My Computer” in the project. Also, the RIO I/O control or constant 
is required to be updated from a local to remote resource name.

External resources, such as databases or other storage devices not available on the RT 
target, might require the coding of a Host PC application.

Note: Since the application runs at the host PC, the some of the processing 
happens at the local PC and not on the target. Therefore, the performance and 
timing is not representative of compared to the results if the whole applications  
was run completely on the target.

Using the AF-1501 in a Different Slot than the Default

The “Getting Started” guide details how to setup a project, compile and run the code so 
that the user can grab an image with an AF-1501 located in Slot 1. This section will 
discuss how to configure the AF-1501 to work in another slot. In order to work with the 
AF-1501 in a different slot the user will need to modify the AF-1501 FPGA driver I/O 
nodes:

1. Locate the AF-1501 FPGA driver in your project.
2. Optional: Save it as a local file in your work folder and call it “AF-1501 FPGA 

Driver vX.X Slot Y”, where vX.X is the version of the FPGA driver and Y is the 
installed slot. This will help avoid confusion which slot the driver is compiled for.

3. Add the saved file to your project in FPGA Drivers folder under FPGA Target 
Tree.

4. Add the module I/O nodes to your project for the slot it is installed in (See Figure
16). To do this, select Add C Series modules … from the FPGA Target tree in 
your project. Select New target or device and select AF-1501 for the Module 
Type. Select the desired slot number from the Location pull-down menu.
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Figure 16: Adding New Module I/O Nodes to the Project

5. Open the FPGA driver VI block diagram.
6. Modify the following FPGA I/O nodes with the new I/O line values. Below is a 

list of I/O values that need to be changed, where Y is the slot to use the AF-1501 
in, for example if using slot 7, then Y=7:
(1) “Mod1/SPI Conv(DIO3)” → “ModY/SPI Conv(DIO3)”
(2) “Mod1/Trigger(DIO1)” → “ModY/Trigger(DIO1)”
(3) “Mod1/SPI MISO (DIO6)” → “ModY/SPI MISO (DIO6)”
(4) “Mod1/OvrSmpClk(DIO0)” → “ModY/OvrSmpClk(DIO0)”
(5) “Mod1/SPI RdyBsy(DIO2)” → “ModY/SPI 

RdyBsy(DIO2)”
(6) “Mod1/SPI Clk” → “ModY/SPI Clk”
(7) “Mod1/ID Select” → “ModY/ID Select”
(8) “Mod1/SPI CS(DIO5)” → “ModY/SPI CS(DIO5)”
(9) “Mod1/SPI Func(DIO4)” → “ModY/SPI Func(DIO4)”

7. Save your VI
8. Compile the VI
9. If the FPGA Driver was renamed, open the”AF-1501 Open” VI from the AF-1501 

palette. Otherwise, skip to the next step. Locate the "Open FPGA reference" node 
and relink it to the new driver file by right-clicking the node and selecting 
“Configure Open FPGA reference”. Select the new VI by clicking the folder path 
icon.
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Available Modes of Operation

Default Configuration

Typically, the user will pick default values as a first choice. The default values give the 
maximum resolution (640x480) and the maximum bit depth (8-bits). If the performance 
is good enough for the user's application, then the default values should suffice. However, 
if the user's application requires more performance then the user can take advantage of 
one or more of the special features. See section Special Features for more details. 

The default values when nothing is wired to the configuration VI are as followed:

X-Size: 640
Y-Size: 480
Bit-Mode: 8-Bit
Invert: Disabled
PSS: Disabled
ROI: Disabled

How to Set the Configuration

The configuration is set by right-clicking the Config (Write) input of either the “AF-
1501 Configure.vi” or “AF-1501 Configure Mode.vi” functions in the User Libraries » 
MoviMED » AF-1501 Palette in LabVIEW and selecting “Create Constant” or “Create 
Control” from the drop-down menu. The values can be changed by either modifying them 
in the constant directly (See Figure 17) or inserting a “Bundle by Name” in between them 
(See Figure 18) and creating constants in a similar fashion to the inputs.

Figure 17: Configure using a Constant Figure 18: Configure using Bundle
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Valid Settings

InTable 1, configuration parameters for valid modes are listed. See section How to Set the
Configuration for more information on configuring the module. Set the image size with X 
Size and Y Size. See sections Progressive Skip Sampling and Programmable Region of
Interest for more details on how to use the ROI and PSS modes.

Mode TL TH X Y Bit Mode ROI PSS Comments

640x480x8 bits N/A N/A 640 480 8-Bit Default

640x480x4 bits N/A N/A 640 480 4-Bit SOM

636x480x1 bit

or

or

or

or
636 480 1-Bit

Threshold

320x240x8 bits N/A N/A 320 240 8-Bit PSS

320x240x4 bits N/A N/A 320 240 4-Bit PSS, SOM

318x240x1 bit

or

or

or

or
318 240 1-Bit

PSS, Threshold

ROI, 8 bits N/A N/A X1-X0 Y1-Y0 8-Bit
X1>X0, Y1>Y0,
X0 = 0 – 639, X1 = 1 – 640,
Y0 = 0 – 479, Y1 = 1 – 480.

ROI, 4 bits N/A N/A X1-X0 Y1-Y0 4-Bit

X1>X0, Y1>Y0,
X0 = 0, 2, 4, … 638, 
X1 = 2, 4, 6, … 640,
Y0 = 0 – 479, Y1 = 1 – 480.

ROI, 1 bit

or

or

or

or
X1-X0 Y1-Y0 1-Bit

X1>X0, Y1>Y0
X0 = 0, 6, 12, … 630,
X1 = 6, 12, 18, … 636,
Y0 = 0 – 479, Y1 = 1 – 480.

ROI, PSS, 8 bits N/A N/A X1-X0 Y1-Y0 8-Bit
X1>X0, Y1>Y0,
X0 = 0 – 319, X1 = 1 – 320,
Y0 = 0 – 239, Y1 = 1 – 240.

ROI, PSS, 4 bits N/A N/A X1-X0 Y1-Y0 4-Bit

X1>X0, Y1>Y0,
X0 = 0, 2, 4, … 318, 
X1 = 2, 4, 6, … 320,
Y0 = 0 – 239, Y1 = 1 – 240.
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Mode TL TH X Y Bit Mode ROI PSS Comments

ROI, PSS, 1 bit

or

or

or

or
X1-X0 Y1-Y0 1-Bit

X1>X0, Y1>Y0
X0 = 0, 6, 12, … 312,
X1 = 6, 12, 18, … 318,
Y0 = 0 – 239, Y1 = 1 – 240.

Test Pattern N/A N/A 640 480
Test 

Pattern

Table 1: Valid Configuration Settings for Various Modes

Special Features

The AF-1501 analog frame grabber allows the user to take advantage of a set of special 
built-in features. These features give the user flexibility to work with different image 
sizes and bit depths, use common image processing tools or have tools to verify the status 
of the system. All special features are implemented at the hardware level in the AF-1501.

Summary of Special Features:

• Progressive Skip Sampling
• Programmable Region of Interest
• Speed Optimized Mode
• Image Inversion
• Hardware Accelerated Thresholding
• Test Pattern Generator

Progressive Skip Sampling

The Progressive Skip Sampling mode (PSS mode) allows the AF-1501 user to increase 
the frame rate by decreasing the resolution. In this mode the AF-1501 will sample every 
other pixel in both horizontal and vertical directions. 
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Figure 19: Progressive Skip Sampling

Figure 20: Jaggedness Due to Interlacing (640x480)

Figure 21: Removed Jaggedness using PSS Mode (320x240)

When to Use PSS

The resulting image acquired using the PSS mode is not interlaced (See Figure 19). PSS 
mode is especially suitable for motion sensitive applications since it removes the 
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jaggedness (See Figure 20) inherent in interlaced images. When using PSS mode, the 
distorting is removed and the resolution is reduced while keeping the same field of view 
(See Figure 21).

How to Use PSS

Set the value for PSS boolean flag to true in the configuration input to enable PSS. Refer 
section How to Set the Configuration for details. 

Programmable Region of Interest
The Programmable Region of Interest (ROI) feature of the AF-1501 allows the user to 
transfer a reduced part of the image directly from the hardware without any additional 
image processing. Figure 22 shows an example of how the programmable ROI works. 

Figure 22: Region of Interest

The frame rate will be affected by the use of a ROI. A smaller ROI will increase the 
frame rate up to the maximum frame rate (dependent on the video standard used), and a 
larger ROI will decrease the frame rate.

When to Use the ROI

The programmable Region of Interest (ROI) feature is especially useful when the user 
only needs a small part of the image. For instance, if the image activity only happens in 
the top part of the image, there is no need to transfer anything beyond that region.

If an application requires a higher frame rate without sacrificing bit depth, the image size 
can be reduced by using a ROI without affecting the application performance.

How to Use the ROI

First, ROI X0, Y0, X1, and Y1 values need to be determined. Table 2 lists the 
requirements for using the ROI. The use of Speed Optimized Mode (SOM/4-bit) requires 
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the ROI X0 and X1 values to be a multiple of 2. For threshold mode (1-bit), the ROI must 
be a multiple of 6. If PSS, is used the range is reduced by half. In addition, the image size 
must be greater than zero.

Mode X0 Range Y0 Range X1 Range Y1 Range
8-Bit, PSS disabled 0 to 639 0 to 479 1 to 640 1 to 480
4-Bit, PSS disabled 0, 2, 4, … 638 0 to 479 2, 4, 6, … 640 1 to 480
1-Bit, PSS disabled 0, 6, 12, … 630 0 to 479 6, 12, 18, … 636 1 to 480
8-Bit, PSS enabled 0 to 319 0 to 239 1 to 320 1 to 240
4-Bit, PSS enabled 0, 2, 4, … 318 0 to 239 2, 4, 6, … 320 1 to 240
1-Bit, PSS enabled 0, 6, 12, … 312 0 to 239 6, 12, 18, … 318 1 to 240

Table 2: Valid Values for the Region of Interest

Second, the first coordinate pair must be to the left and above the second pair. 

Therefore: X1 > X0 and Y1 > Y0.

Third, the ROI values must be written to the module, and the ROI feature must be 
enabled. Follow these steps to configure the ROI (See How to Set the Configuration and 
Table 2 for more details):

1. Set a valid ROI X0 value in the configuration.
2. Set a valid ROI X1 value in the configuration.
3. Set a valid ROI Y0 value in the configuration.
4. Set a valid ROI Y1 value in the configuration.
5. Set the ROI boolean flag in the configuration to TRUE to enable the ROI feature.
6. Set the X Size and Y Size to the difference between the right and left, and bottom 

and top coordinate values, respectively.
 

Note: The ROI values must match the image size.
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Figure 23: Image without ROI
Figure 24: Smaller Image using ROI

Speed Optimized Mode (4-bit)

The Speed Optimized Mode (SOM) allows the AF-1501 user to reduce bit depth for a 
higher frame rate. In this mode, the AF-1501 will represent each pixel with four (4) bits 
instead of the eight (8) bits used the in normal mode of operation. The resulting image 
will have 14 different gray levels instead of 254 gray levels. As a result, the image 
transaction (frame rate) will increase. The output image will only use the upper 4-bits for 
image data when decoded. As a result, the range will still be within 1 to 254 as before, 
except with a granularity of 16. 

Figure 25: Image of Bracket in 8-Bit Mode Figure 26: Image in 4-Bit Mode (SOM)

When to Use SOM

If the imaging application does not require to tell apart gray levels very close together, 
then SOM mode could be used. The requirement, however, is that the gathered images 
have a high enough contrast ratio. SOM mode will yield a higher frame rate because the 
image data is transferred from the module faster at a lower bit depth. Also, SOM can be 
used to mask image noise occurring in the lower 4 bits of the image.

How to Use SOM

Set a valid image size with the X Size and Y Size controls. Select “4-Bit” for Bit-Mode 
in the configuration control (See How to Set the Configuration for more details). 
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SeeTable 1 in Valid Settings for a list of valid configurations. If the ROI/PSS are enabled, 
see Table 2 in the section Programmable Region of Interest for requirements in this 
mode. 

Image Inversion

The image data can be optionally inverted. Inversion is performed bit-wise in hardware 
and is especially useful with the thresholding feature. See Figure 27 and Figure 28 for 
details:

Figure 27: Original Image of a sbRIO PCB Figure 28: Inverted Image of a sbRIO PCB

When to Use Image Inversion

Sometimes using a bit-wise inverted image is more convenient than a regular image. One 
application for this feature is in thermography. Some thermal cameras output data as 
“black-hot”. This means that higher temperature values are encoded as darker pixel 
values. So, if the application was to locate a hot spot, then the output would need to be 
inverted if the detection algorithm requires “white-hot” values. Also, it might be more 
convenient for displaying this type of data with higher temperatures as lighter pixels 
values.

How to Use Image Inversion

To enable image inversion, set the Invert boolean flag in the configuration settings (See 
How to Set the Configuration for more details). Image inversion feature is compatible 
with all other features (8-bit, SOM/4-bit, Threshold/1-bit, PSS, ROI) and ignored with the 
Test Pattern mode. 

Hardware Accelerated Thresholding (1-bit)

The Hardware Accelerated Thresholding feature of the AF-1501 allows the user to do a 
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binary threshold on the incoming image at the hardware level. This has the effect of 
masking the image for pixel values within a range. Once the image is threshold-ed, the 
module outputs a single bit per pixel (1) which results in a notable reduction in transfer 
time. Figures 32, 31, and 33 show the effects of different threshold settings on a gray-
scale image (Figure 30). The same concept is applied in Figure 34 with a real image. 
Note the shadow is detected in Figure 35 using the low threshold mode. Using both 
thresholds (See Figure 37) is useful for detecting when parts of an image are in a certain 
range (windowing) or excluding a range (when image inversion is enabled), for example, 
in sorting operations. Using the high threshold (See Figure 36) is useful to compensate 
for black level shift.

There are three different Hardware Accelerated Thresholding options as depicted in 
  Figure 29:

a) Threshold Low: the output value is true if the pixel value is below the Threshold 
Low value.

b) Threshold High: the output value is true if the pixel value is above the Threshold 
High value.

c) Both Thresholds: the output value is true if the pixel value is below the Threshold 
Low value and above the Threshold High value.

Figure 29: Thresholding
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Figure 30: Original Image Before 
Thresholding

Figure 32: Image After using a High 
Threshold of 70

Figure 33: Image After using a Both 
Threshold Modes (Window)

Figure 34: Original Image of AF-1501 Figure 35: Low Threshold of 220

Figure 36: High Threshold of 220 Figure 37: Combined Threshold 
Modes
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When to Use Threshold Mode

Simple image processing applications can take advantage of the use of Hardware 
Accelerated Thresholding, for example: finding a white dot in a black background, a 
robot navigating based on high-contrast fiducial, or thermal alarms when using analog 
thermal cameras. In general, Thresholding should be enabled when the image has a low 
contrast ratio. Windowed Hardware Accelerated Thresholding (both high and low 
thresholds enabled) is especially convenient for simple edge detection. The continuity of 
the data makes edges to be always in a pixel value range that can be detected using this 
feature.

How to Use Threshold Mode

In order to use the Hardware Accelerated Thresholding, the user needs to set the image 
size, enabled thresholds, and set the bit-depth (See How to Set the Configuration for more 
details). SeeTable 1 in Valid Settings for a list of valid configurations. If the ROI/PSS are 
enabled, see Table 2 in the section Programmable Region of Interest for requirements in 
this mode. Set use Threshold mode, follow these steps:

1. Input a valid image size. (See Table 1 and Table 2). 
2. Select the "1-Bit Mode" in the Bit-Mode element on the configuration. Set one of 

the following threshold mode boolean flags to TRUE: Threshold High, Threshold 
Low, or Threshold Low and High (Windowing Mode) .

Note: If no threshold filter is selected, the resulting image will be all zero 
values.

3. Set the Threshold High/Threshold Low or both value(s). Incoherent values could 
lead to zero or one images, See Figures 29 through 37 to understand the behavior 
of the thresholding values. 

Note: When using IMAQ indicators and Threshold mode images have 
only two levels (0 or 1) and the user should adjust the palette to binary. This can 
be done by right-clicking the IMAQ indicator and selecting Palette » Binary.

Test Pattern Generator

The AF-1501 can be set to output internally generated test patterns. This feature allows 
the user to transfer images from the module to the backplane without the need of an 
analog video source. The test patterns are only available at 640x480 (full) resolution in 8 
bit mode. They are not compatible with ROI, PSS, image inversion, or SOM.
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The available test patterns are listed and depicted in Table 3:

0, All Black 4, Vertical Lines

1, Horizontal Gradient 5, Grid

2, Vertical Gradient 6, Checkerboard

3, Horizontal Lines 7, All White

Table 3: Available Test Patterns

When to Use a Test Pattern

The test patterns are particularly useful when setting up a system with an AF-1501. If we 
want to check that the module behaves normally (images transfer correctly) when we 
have compiled the FPGA driver code and deployed the RT drivers to the target, it is 
useful to configure the module to output a test pattern. The fact that test patterns are not 
noisy can also be helpful in particular applications such as: setting reference values, 
calibration, etc.

How to Use the Built-In Test Patterns

In order to use a test pattern, the user needs to set the following values in the 
configuration (See the Valid Settings and How to Set the Configuration sections).
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1. Set an image size of 640x480.
2. Select the "8-Bit Test Pattern" in the Bit-Mode element on the configuration input.
3. Select the test pattern you want to use in the “Test Pattern” element on the 

configuration input .

Feature Inter-compatibility

 Table 4 lists the various combinations of features and their compatibility with each other. 
Multiple features can be used simultaneously. For example, PSS, ROI, and 4-bit (SOM) 
can be used simultaneously. One example of this would be: X Size = 100, Y Size = 25, 
Mode = 4-bit, ROI = TRUE, PSS = TRUE, ROI X0 = 50, ROI Y0 = 175, ROI X1 = 
150, ROI Y1 = 200.

Mode PSS 1-bit 4-bit 8-bit ROI Invert Test Pattern

PSS      

1-bit    

4-bit    

8-bit    

ROI      

Invert      

Test Pattern      

Table 4: Special Feature Inter-compatibility Chart

Sleep Mode

This module supports a low-power sleep mode. Support for sleep mode at the system 
level depends on the chassis that it is plugged into. Refer to your chassis documentation 
for information regarding support for sleep mode functionality. You can enable sleep 
mode in software. Refer to you driver software documentation for more information.

Specifications

The following specifications are typical for the range –40 °C to 70 °C unless otherwise 
specified. 

Input Characteristics
Number of channels...........................1
Input type...........................................Analog
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Video standards..................................NTSC (M,4.43), PAL (B,G,H,I,N,M), SECAM
Internal ADC......................................9-bit
Input impedance.................................75 Ω ± 1%

Digital Data Format
Resolution..........................................1x1 to 640x480
Bit Depth............................................8-bit/4-bit/1-bit
Levels.................................................254/14/2
Real-time OS driver...........................IMAQ or Image Array

Power Requirements
Power consumption from chassis

Active mode (transfer)...........1 W max.
Active mode (idle).................350 mW max.
Sleep mode.............................<5 mW

Physical Characteristics
Form factor.........................................C Series
Weight................................................140 g. (5.0 oz.)

Electromagnetic Compatibility
Emissions...........................................EN 55022 
Immunity............................................EN 55024
EMC/EMI..........................................CE Compliant

CE Compliance
This product meets the essential requirements of applicable European directives, as 
amended for CE markings as follows:

Low-Voltage Directive (safety)..........2006/95/EC
Electromagnetic Compatibility 
Directive (EMC)................................2004/108/EC

Note: Refer to the Declaration of Conformity (DoC) for this product for  
any additional regulatory compliance information.
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Application Programming Interface

Opening a Session to the AF-1501

Reset Module? resets the AF-1501 module hardware.
F = Don't Reset Module
T = Reset Module

RIO Device selects the RIO target name to open. 

Slot selects the RIO chassis slot number.

Session is the reference number to the open session to the AF-1501. 

error in (no error) can accept error information wired from VIs previously 
called. Use this information to decide if any functionality should be bypassed in 
the event of errors from other VIs. Right-click the error in control on the front 
panel and select Explain Error or Explain Warning from the shortcut menu for 
more information about the error. 

status is TRUE (X) if an error occurred before this VI or function ran or 
FALSE (check mark) to indicate a warning or that no error occurred before 
this VI or function ran. The default is FALSE.

code is the number identifying an error or warning. If status is TRUE, code 
is a non-zero error code. If status is FALSE, code can be zero or a warning 
code. Use the error handler VIs to look up the meaning of this code and to 
display the corresponding error message.

source describes the origin of the error or warning and is, in most cases, 
the name of the VI or function that produced the error or warning. The 
default is an empty string.

error out passes error or warning information out of a VI to be used by other Vis.
status is TRUE (X) if an error occurred before this VI or function ran or 
FALSE (checkmark) to indicate a warning or that no error occurred before 
this VI or function ran. The default is FALSE.
Right-click the error in control on the front panel and select Explain Error or 
Explain Warning from the shortcut menu for more information about the 
error.
code is the number identifying an error or warning. If status is TRUE, code 
is a non-zero error code. If status is FALSE, code can be zero or a warning 
code. Use the error handler VIs to look up the meaning of this code and to 
display the corresponding error message.
Right-click the error in control on the front panel and select Explain Error or 
Explain Warning from the shortcut menu for more information about the 
error.
source describes the origin of the error or warning and is, in most cases, 
the name of the VI or function that produced the error or warning. The 
default is an empty string.
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Right-click the error in control on the front panel and select Explain Error or 
Explain Warning from the shortcut menu for more information about the 
error.

Configuration of the AF-1501

R/W specifies whether the configuration is to be set or queried. A value of FALSE 
passed to this VI reads the configuration of the AF-1501 and outputs it to 
Configuration (Read) while a value of TRUE passed writes the configuration 
passed from Configuration (Write) to the AF-1501.

Timeout sets the time in milliseconds (ms) for data transfer to/from the AF-1501 
to expire and return an error to error out.

X Size sets the horizontal resolution of the image.

Y Size sets the vertical resolution of the image.

Image Size returns the area of the image.

Session is the reference number to the open session to the AF-1501. 

Session (dup) is a duplicate of the reference number passed in from Session.

Configuration (Write) Settings to send to the AF-1501.
High Threshold
FALSE : High threshold not used on image data. 
TRUE: Output TRUE data if image value is greater than threshold value, 
otherwise FALSE. If more than one threshold value is enable, the result is 
logically AND-ed.
Low Threshold
FALSE : Low threshold not used on image data. 
TRUE: Output TRUE data if image value is less than threshold value, 
otherwise FALSE. If more than one threshold value is enable, the result is 
logically AND-ed.
Channel selects the which input on the front panel to use (AF-1502/AF-
1502C only).
Invert Inverts the image.
Bit Mode Selects the output bit depth or test pattern.
0 8-Bit Mode (Normal)

1 4-Bit Mode (SOM)

2 1-Bit Mode (Threshold)

3 8-Bit Test Pattern Mode
Region of Interest Enables hardware image cropping (ROI) with values in 
ROI registers.
Progressive Skip Sampling If a value of FALSE is passed, the output 
screen resolution is normal, and if a value of TRUE is passed, the output 
screen resolution is reduced in half.

AF-1501 Operating Instructions www.movimed.com Page 34

http://www.movimed.com/


MoviMED
15540 Rockfield Blvd., Suite C-110

Irvine, CA 92618
949-699-6600 Phone

949-699-6601 Fax

Rev.: 4 02/19/2010

FALSE = Normal output
TRUE = Skip every other pixel
ROI X0 Top left window horizontal pixel value
ROI X1 Bottom right window horizontal pixel value
ROI Y0 Top left cropping window vertical pixel value
ROI Y1 Bottom right cropping window vertical pixel value
Threshold (Low) Lower threshold value
Threshold (High) High threshold value

Configuration (Read) Settings read from the AF-1501. (same as previous). 

error in (no error) (same as previous). 

error out (same as previous). 

Grabbing Images from the AF-1501

Session is the reference number to the open session to the AF-1501. 

Session (dup) is a duplicate of the reference number passed in from Session.

Timeout sets the time in milliseconds (ms) for data transfer to/from the AF-1501 
to expire and return an error to error out.

  or
Image Out returns a reference to the IMAQ image.

Image Out returns the image as a 2D array of unsigned 8-bit integers (U8).

Pieces is the number of fragments to transfer an image from the frame buffer.

FPS returns the calculated frame rate of the image during transfer.

error in (no error) (same as previous). 

error out (same as previous). 

Closing a Session to the AF-1501

Session is the reference number to the open session to the AF-1501. 

error in (no error) (same as previous). 
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error out (same as previous). 

Advanced API Functions

Using Auto Configure

Mode sets the mode from a list of image settings:
0 640x480x8 8 1-Bit using ROI 16 Horizontal Lines

1 640x480x4 9 8-Bit using ROI and PSS 17 Vertical Lines

2 636x480x1 10 4-Bit using ROI and PSS 18 Grid

3 320x240x8 11 1-Bit using ROI and PSS 19 Checkerboard

4 320x240x4 12 Separator (same as 0) 20 All White

5 318x240x1 13 All Black 21 Separator (same as 0)

6 8-Bit using ROI 14 Horizontal Gradient 22 Reserved (same as 0)

7 4-Bit using ROI 15 Vertical Gradient 23 Reserved (same as 0)

Threshold sets the thresholding mode.
0 Low Threshold

1 High Threshold

2 Threshold Window (Both)

Thresholds sets the thresholding values. 
Threshold (Low) Lower threshold value

Threshold (High) High threshold value

Channel selects the which input on the front panel to use (AF-1502/AF-1502C 
only).

Invert Inverts the image.

ROI sets the Region of Interest. 
ROI X0 Top left window horizontal pixel value.

ROI X1 Bottom right window horizontal pixel value.

ROI Y0 Top left cropping window vertical pixel value.

ROI Y1 Bottom right cropping window vertical pixel value.

Thresholds sets the thresholding values.

Timeout sets the time in milliseconds (ms) for data transfer to/from the AF-1501 
to expire and return an error to error out.
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Session is the reference number to the open session to the AF-1501.

Session (dup) is a duplicate of the reference number passed in from Session.

error in (no error) (same as previous). 

error out (same as previous). 

Configuring the Image Mode

R/W specifies whether the configuration is to be set or queried. A value of FALSE 
passed to this VI reads the configuration of the AF-1501 and outputs it to Mode 
(Read) while a value of TRUE passed writes the configuration passed from Mode 
(Write) to the AF-1501.

Timeout sets the time in milliseconds (ms) for data transfer to/from the AF-1501 
to expire and return an error to error out.

X Size sets the horizontal resolution of the image.

Y Size sets the vertical resolution of the image.

Session is the reference number to the open session to the AF-1501. 

Session (dup) is a duplicate of the reference number passed in from Session.

Mode (Write) Settings to send to the AF-1501.
High Threshold
FALSE : High threshold not used on image data. 
TRUE: Output TRUE data if image value is greater than threshold value, 
otherwise FALSE. If more than one threshold value is enable, the result is 
logically AND-ed.
Low Threshold
FALSE : Low threshold not used on image data. 
TRUE: Output TRUE data if image value is less than threshold value, 
otherwise FALSE. If more than one threshold value is enable, the result is 
logically AND-ed.
Channel selects the which input on the front panel to use (AF-1502/AF-
1502C only).
Invert Inverts the image.
Bit Mode Selects the output bit depth or test pattern.
0 8-Bit Mode (Normal)

1 4-Bit Mode (SOM)

2 1-Bit Mode (Threshold)

3 8-Bit Test Pattern Mode
Region of Interest Enables hardware image cropping (ROI) with values in 
ROI registers.
Progressive Skip Sampling If a value of FALSE is passed, the output 
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screen resolution is normal, and if a value of TRUE is passed, the output 
screen resolution is reduced in half.
FALSE = Normal output
TRUE = Skip every other pixel

Mode (Read) Settings read from the AF-1501. (same as previous). 

error in (no error) (same as previous). 

error out (same as previous). 

Configuring the Region of Interest

R/W specifies whether the configuration is to be set or queried. A value of FALSE 
passed to this VI reads the configuration of the AF-1501 and outputs it to ROI 
(Read) while a value of TRUE passed writes the configuration passed from ROI 
(Write) to the AF-1501.

Timeout sets the time in milliseconds (ms) for data transfer to/from the AF-1501 
to expire and return an error to error out.

Session is the reference number to the open session to the AF-1501. 

Session (dup) is a duplicate of the reference number passed in from Session.

ROI (Write) Settings to send to the AF-1501.
ROI X0 Top left window horizontal pixel value
ROI X1 Bottom right window horizontal pixel value
ROI Y0 Top left cropping window vertical pixel value
ROI Y1 Bottom right cropping window vertical pixel value

ROI (Read) Settings read from the AF-1501. (same as previous). 

error in (no error) (same as previous). 

error out (same as previous). 

Configuring the Threshold Levels

R/W specifies whether the configuration is to be set or queried. A value of FALSE 
passed to this VI reads the configuration of the AF-1501 and outputs it to 
Threshold Settings (Read) while a value of TRUE passed writes the 
configuration passed from Threshold Settings (Write) to the AF-1501.
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Timeout sets the time in milliseconds (ms) for data transfer to/from the AF-1501 
to expire and return an error to error out.

Session is the reference number to the open session to the AF-1501. 

Session (dup) is a duplicate of the reference number passed in from Session.

Threshold Settings (Write) Settings to send to the AF-1501.
Threshold (Low) Lower threshold value
Threshold (High) High threshold value

Threshold Settings (Read) Settings read from the AF-1501. (same as 
previous). 

error in (no error) (same as previous). 

error out (same as previous). 

Configuring the Test Pattern

R/W specifies whether the configuration is to be set or queried. A value of FALSE 
passed to this VI reads the configuration of the AF-1501 and outputs it to Mode 
(Read) while a value of TRUE passed writes the configuration passed from Mode 
(Write) to the AF-1501.

Timeout sets the time in milliseconds (ms) for data transfer to/from the AF-1501 
to expire and return an error to error out.

Session is the reference number to the open session to the AF-1501. 

Session (dup) is a duplicate of the reference number passed in from Session.

Test Pattern (Write) Set selected test pattern:
0 Black Screen

1 Vertical Gradient

2 Horizontal Gradient

3 Vertical Lines

4 Horizontal Lines

5 Grid

6 Checkerboard

7 White Screen

Test Pattern (Read) Get the selected test pattern. (same as previous). 

error in (no error) (same as previous). 

error out (same as previous). 
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